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This tutorial will offer you some advice on how to use Scribus to 
prepare an optimized digital edition PDF book. 

There are two ways to produce a digital edition PDF presented in 
this tutorial. One way will use Scribus to directly export a PDF at a 
resolution appropriate for viewing on computers and devices. The 
other will use Acrobat Pro to optimize an existing high-resolution PDF. 
If you do not have Acrobat Pro and wish to test this process, you can 
download a trial version from the Adobe website: www.adobe.com.

The Tutorial is Broken up into Sections:
1. Setting Up Your Scribus Document
2. Adding Cover Images and Setting Up Pagination
3. Adding Bookmarks
4. Adding Hyperlinks
5.  Exporting Your Scribus File as a PDF Ebook
6. Optimizing a High Resolution PDF using Acrobat Pro
7. Tips and Things to Remember
8. What Do I Do Next?
9. I Need More Help!

What Do I Need?
This tutorial will have you use Scribus to create your content and 
cover and export them as a PDF digital edition ebook. 

The screenshots shown in the tutorial use Scribus 1.4.0.rc2 for 
Mac and Acrobat Pro 9 and X for Mac. If you are using different 
versions of the software, some of the instructions and screenshots 
will be slightly different, but hopefully you can fi nd the right feature 
in your software version.

How Do I Get This Software?
Scribus is available for free at www.scribus.net. Scribus is an Open 
Source program that brings professional page layout to Linux/UNIX, 
Mac OS X, OS/2 Warp 4/eComStation and Windows desktops.

How to Prepare a Digital Edition PDF Book With Scribus
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For your convenience, we have created a few template fi les for 
different standard book sizes to make your layout work easier. You 
can fi nd these templates on the Digital Tutorials and Templates 
of the Publisher Knowledge Base, under Title Management/ 
Digital Titles.

Setting up your fi le is nearly identical to setting up a book for print 
but the specifi cations are much looser. If you plan to produce both 
print and digital editions, you should set up your book fi les to print 
specs and then produce a digital book from the same fi les. 
For more information about the mechanics of setting up your 
Scribus fi le for print, e.g., creating Master Pages, importing and 
styling text using Style Sheets, and placing art, see the DriveThru 
tutorial for Scribus on the Print Templates and Tutorials page 
of the Publisher Knowledge Base, under Title Management/ 
Book Printing.

Open Scribus. Then in the File pull-down menu, open the template. 
Make sure you are using the right template for your book size.

The Anatomy of a Digital Book Page 
•  Red line: This is the edge of the page. It’s called the “trim” or 

“trim line.” Art and text should not go past it.
•  Blue line: This is called the “safe area,” which is a convention 

followed in books prepared for press. Text, art that doesn’t 
“bleed” to the edge of the page, and any other important 
elements are placed inside this area of the page. In print book 
production, the size of this margin is not negotiable; text and 
art can be well inside this margin but can never go outside of 
it as they may be affected when the printed paper gets cut or 
“trimmed.” For a digital book, the size of this margin is more of 
a suggestion than a hard-and-fast rule, so it can be adjusted to 
better fi t your content.

1. Setting Up Your Scribus Document
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2. Adding Cover Images and Setting Up Pagination

Before you begin any method of PDF export described, make sure 
your front and back cover fi les are the fi rst and second pages of your 
PDF digital edition. 

You can add two pages to the beginning of your interior text fi le 
document, and then place your cover images on those pages. 
Then, you will want to change the pagination of the cover pages 
to Roman numerals (i, ii). This is a good idea to do because the 
cover pages won’t goof up the interior book block pagination. 
Those page numbers will still reference the Table of Contents.

To add pages to your Scribus document, pull down the Pages menu 
at the top of your screen. The Insert Page dialog box will open. In the 
Insert Page(s) fi eld, add 2. Set the drop-down menu to before Page, 
then make sure the page number to the right is set at 1. Click OK.

Next you need to set up your page numbers. Pull 
down the File menu from the top of your screen, 
then select and open Document Setup. The 
Document Setup dialog box will open. From the 
list at the left-hand side of the box, scroll down to 
and select Sections. Click the Add button at the 
bottom of the box to add a new section. You may 
have to click through an error or warning box to 
add one. This is okay.

Manually change the row 
0 to refl ect From page 1
and To page 2, then pull 
down to the Style drop-
down menu to choose 
Roman numerals (i, ii, iii). 
Then manually change 
row 1 to refl ect From 
page 3 and To whatever 
the last page of the 
document is, then pull down the Style drop-down menu to choose 
Arabic numerals (1, 2, 3). Click Apply, then OK.

Now if you check your Document Pages in your Arrange 
Pages palette, you can see that the correct pagination is 
in effect.

Now, place your cover images. Just follow the instructions 
in this tutorial under Adding Art and/or Adding and 
Formatting Text.
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This is easily corrected. Using your mouse cursor, just drag and 
drop your bookmarks to rearrange them. 

The screenshot to the right illustrates 
that you can even nest a bookmark 
underneath another bookmark, 
creating sublevels. 

Remember to test the bookmarks 
in your fi nal exported PDF to make 
sure the page destinations you have 
established are all correct.

To make navigating through a large PDF book easier, bookmarks can 
be made in your Scribus document, which can be exported and used 
in your fi nal PDF digital edition. A good use of bookmarking is to place 
one at the fi rst page of every chapter in your book, so readers can 
jump straight to the chapter of the book where they last left it.

There are a few things about bookmarks in Scribus you should 
know before you begin. The fi rst is that bookmarks can only be 
made using text frames. The second is that bookmarks are not 
listed in the order they occur in the document, but rather by the 
order they were created. That means you will want to review the 
order of your bookmarks before you export your fi nal PDF and 
rearrange them as necessary.

First, make sure your 
Bookmark palette is open. 
Expand the Windows
menu at the top of your 
screen. If Bookmarks is 
checked, your palette is 
open somewhere. If it’s 
not checked, select it to 
open it now.

Now right-click on the 
text box you would like 
to set as a bookmark. 
A contextual menu will 
open. Navigate to PDF 
Options, then select Is 
PDF Bookmark. Repeat 
this action on every text 
box in your document 
that you would like to 
bookmark.

Now check your Bookmarks palette. 
You will see a list of Bookmarks you 
have made. As you can see below, 
when compared to my TOC to the right, 
my bookmarks are not in document 
order.

3. Adding Bookmarks

hem. 
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The Annotation Properties dialog box will 
open. From the Type drop-down menu, 
choose Link. 

Then set your Destination details. Choose 
the correct page number in the Page fi eld, 
either by clicking through using the arrows 
or by directly typing the page number into 
the fi eld.

A thumbnail of your selected page will 
display in the window to the right. Your 
mouse cursor will turn into crosshairs when you hover over this 
thumbnail image. Click on the part of the page in the thumbnail 
you would like to set as your link destination. The X and Y 
coordinates of that location will automatically calculate. Click OK.

Adding links to destinations outside your document
To set an external destination, such as a web link, begin the same 
way. Select the Insert Link Annotation button from the PDF Tools 
bar and draw a box over your source area. Right-click to expand 
the contextual menu, navigate down to PDF Options, and choose 
Annotation Properties.

Now, choose External Web-Link from the 
Type menu. In the Destination fi eld, type 
or paste the web URL you intend to use. 
(Don’t forget to include the “http://” part of 
the address!)

In some digital books, you may want to add links between pages 
that occur in your document, such as links from the entries in your 
Table of Contents to your chapter starts, or links to destinations 
outside your document, such as a web URL. Scribus can do these!

If you choose to add interactivity to your digital edition, make sure to 
test each created link in your fi nal PDF after export. 

Adding links between pages
To add a link from one page to 
another, fi rst make sure that 
your PDF Tools bar is open 
and available for use. To fi nd 
this, expand the Windows pull-
down menu from the top of 
your screen and make sure 
PDF Tools is checked.

Find the PDF Tools bar. It 
looks like this screenshot to 
the right. Click the Insert Link 
Annotation button. It looks 
like two manly footprints.

Now draw a box around your 
source area, then right-click 
on it to expand a contextual 
menu. Navigate down to 
PDF Options and choose 
Annotation Properties.

4. Adding Hyperlinks
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Once you have inserted your cover images and corrected your 
pagination, pull down the File menu, navigate down to Print. 
Then select Save as PDF.

5. Exporting Your Scribus File as a PDF Ebook

Now that you’ve completed setting up your book, exporting it as a 
digital PDF ebook is easy! 

There are two methods covered in this tutorial:

1.   Export a PDF directly from Scribus, adjusting your PDF export 
settings to make them appropriate for viewing on a computer, 
a tablet or other mobile device. 

2.  Use an existing high-resolution or high quality PDF and optimize 
it in Acrobat Pro using the Prefl ight Print Production Tool.
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Under the Fonts Tab, 
a list of available 
fonts should be 
listed. Click Embed 
All at the right to 
include all the 
document fonts in 
your PDF fi le.

Under the Viewer 
Tab, make sure the 
Single Page radio 
button is checked 
under Document 
Layout, and Use 
Viewers Defaults 
under Visual 
Appearance.

A print dialog box will 
open. The General Tab 
should be the fi rst of 
six tabs you will see. In 
the Output to File fi eld, 
change the name of 
your PDF book to make 
sure you don’t overwrite 
any high-resolution PDF 
versions.

After you have saved 
your fi le with a new 
name, start by making 
these changes in the General Tab.

• File Options - 
Compatability: 
PDF 1.5 (Acrobat 6)

• File Options - 
Check Include 
Bookmarks if your 
fi le has Bookmarks.

•  Compression 
Method: Automatic

•  Compression 
Quality: High

• Maximum Image 
Resolution: 150 dpi

5. Exporting Your Scribus File as a PDF Ebook (continued)
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Under the Pre-Press 
Tab, make sure your 
document bleed is 
set to 0 inches all 
around.

8

You may wish to check your fi nal PDF on multiple computers 
or tablets before uploading it to your Publisher Account. 
This ensures that your digital book looks the way you want 
across many different devices and that no export errors were 
inadvertently made. It gives you a chance to correct any settings 
and fi x any problems before the book goes live for sale.

THIS BIT IS 
IMPORTANT! 
Please do not use 
any Security settings 
in your digital edition 
export. The ability to 
copy/paste or print 
the digital edition 
can be managed on 
out site under the 
File Security settings 
in your Product File 
information when 
you upload the book. 
Any security settings 
imposed on your uploaded digital edition will hinder our automatic 
watermarking process during customer check-out.

Under the Color 
Tab, make sure the 
Output Intended For 
drop-down menu is 
set to Screen/Web.

5. Exporting Your Scribus File as a PDF Ebook (continued)

When you’ve fi nished adjusting your export settings, click Save to 
export your digital edition PDF.
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The Prefl ight dialog box will open. 
Expand the profi les for Digital 
printing and online publishing, and 
choose Online publishing (optimize 
for quality). Then click the Analyze 
and fi x button at the bottom right-
hand corner of the box.

A dialog box will open, prompting you to save the fi le. Make sure to 
change your fi le name slightly so as not to overwrite your high-resolution 
print PDF fi le. Click Save. Then the Prefl ight process will begin.

Once Prefl ighting is done, the 
Prefl ight dialog box will list a report 
of tasks completed. If your fi le was 
successfully processed, a green 
check mark will appear in the top 
left-hand corner of the window. If 
it failed, a red X will appear in the 
same place. On failure, you can 
poke through the process report in 
the dialog box to see what elements 
failed, and then go back and fi x 
those elements before trying to 
Prefl ight again.

6. Optimizing a High Resolution PDF using Acrobat Pro

Using the Prefl ight Print Production tool

Acrobat X

Acrobat 9 and earlier

To learn more about using 
Adobe Acrobat Pro for book-
marking and hyperlinking, refer 
to DriveThru’s Quick Specs on 
the How do I prepare download 
fi les for my digital title? page 
of the Publisher Knowledge 
Base, under Title 
Management/Digital Titles.

You can take a high-resolution 
PDF and process it for web and 
device viewing by using this tool in 
the full version of Adobe Acrobat. 
Again, your fi le should include 
the front and back covers at the 
front of the document and have 
pagination that sets those pages 
off from the rest of the book.

Open your PDF fi le in Adobe 
Acrobat. Depending on the version 
of Acrobat that you are using, you 
can either expand the Tools pane 
from the upper right hand corner 
of your window, expand the Print 
Production tools and navigate 
down to Prefl ight (Version X) or pull 
down the Advanced menu from the 
application bar, and navigate down 
to Prefl ight (Versions 9 and earlier).
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Specifi cations
Although exporting your PDF using the methods provided will take 
care of most of the specifi cations required of a digital PDF ebook, 
there are a few things that are important enough to bring to your 
attention again. These points are listed in DriveThru’s Quick Specs 
document and Quick Check List, both of which can be found on 
the How do I prepare download fi les for my digital titles? page 
of the Publisher Knowledge Base, under Title Management/ 
Digital Titles.

•  DO NOT use JPEG2000 compression in any linked or 
embedded JPEG art fi les, even if it reduces your fi le size. 
  Apple’s iPad and iPhone cannot display images using 

JPEG2000 compression.

• DO NOT use PDF/A profi le compliance for your exported PDF.

•  DO NOT use transparency in your document or images. 
  Apple’s iPad and iPhone also have problems displaying 
fi les with transparency attributes.

•  DO NOT lock or use security settings in your exported PDF. 
This means imposing password protection as well as turning 
off the ability to copy/paste or print from the PDF. 
  These options can be managed under the File Security 

settings in your Product File information on the DriveThru 
site when you upload your book. Any security settings 
imposed on your uploaded digital edition will cause errors 
during the automatic watermarking process at the point of 
customer check-out.

7. Tips and Things to Remember 8. What Do I Do Next?

Once you have fi nished producing and testing your new digital 
edition formats, you’re ready to upload! 

Log into your DriveThru account, and go to your Publisher Hub 
on the Publish page. If you have not already set up a title record, 
go to TITLE MANAGEMENT/Set up a new title to do so. 

If you have any questions or need more information about how to 
proceed with fi lling out this form, you may also fi nd it helpful to follow 
our Book Walkthrough located in the Publisher Knowledge Base.

After a successful upload, you can choose to activate your title for 
live sale! How exciting!

9. I Need More Help!

Your publisher service rep is not really an expert on digital 
layout, so chances are slim that he or she will be able to answer 
questions not answered in this tutorial. However, please do email 
us your questions anyway so we can help fi nd an answer if we 
can and also so that we can improve this tutorial so it answers 
more questions for everyone.
If you have decided that you don’t care to do your own fi le layout, you 
can fi nd people with professional skills and contract them to create 
your print fi les. The cost of this work depends on how much of the 
work you do yourself before handing it over. You can fi nd freelance 
layout professionals at sites like www.upwork.com.

We can also recommend someone for layout if you would like. 
Please contact Publisher Services for details.
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